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Introduction

Integrated Capstone Online Data Entry System (iCODES) is an online management system 
designed to manage Capstone Project, for student grouping, assessment, monitoring and 
reporting. Since it is a live system, and come with an interactive dashboard, monitoring the 
assessment process become seamless.

With iCODES, the scheduling & student grouping are performed automatically while the 
assessment & feedback are carried-out online, enabling centralized and systematic monitoring 
and management processes.

iCODES main architecture is the seamless live integration of the following 3 main Google Sheets 
files:

1. Lead Coordinator File 
2. Coordinator File
3. Facilitator File

This manual is a guide on how to use and setup the above Google Sheets files. 
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iCODES Google Tools Integration
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Managing Google Accounts

iCODES involve admin, coordinators, facilitators, industry panel and students as the users with 
different Google accounts. Below is how the status of these users for the iCODES files should be 
set.

Table 2: Users Status
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N
o File Admin Coordinator Facilitator / 

Industry Panel Student

1 Master Files Owner - - -

2 Lead Coordinator 
file Owner Editor - -

3 Coordinator File Editor with permission to 
edit protected sheets Owner - -

4 Facilitator file Editor with permission to 
edit protected sheets Owner Editor -

5 Google Forms Owner Editor - -

6 Student Activity 
Form Owner Editor Editor Editor



File Ownership and Permission

When other than the owner copied a file 
(especially the coordinators): 

1. The ownership of the file will be 
changed to the one who copied. The 
original owner status is changed to 
editor.

2. The permission to edit protected 
sheets will be given only to the one 
who copied. The original owner will 
have the permission only to view the 
protected sheets.

3. To keep the original permission to 
edit the protected sheets, the file 
must be copied from within the 
Google Sheets apps by selecting the 
option ‘Share it to the same people’.
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Basic Google 
Sheets Layout

1. Filename

2. File URL

3. Save Status

4. User

5. Sheets navigation

6. Sheets
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Facilitator File
01
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Accessing the Facilitator File

● Facilitator files created by the coordinator will be shared to the facilitator using the 
@utm.my email (or other Gmail account given to the coordinator).

● To access the facilitator file, click the link given by the coordinator, or search the file in the 
shared folder of your Google Drive.

● When opening the file, make sure the web browser is login with the same Google account 
use in sharing the file.

● Once successful accessing the file, the following tab can be found:

1. Weekly forms
2. Conceptual presentation form
3. Final product presentation form
4. Peer Review
5. CAPSTONE Group and Schedule
6. Marks Summary
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Weekly Forms

1. Table with the dark 
blue header is the 
current assessment 
week

2. Highlighted student 
name is the student to 
be individually 
assessed for the 
current week.

3. Yellow boxes is the 
dropdown marks.

4. Assessment progress.

*Fill in the yellow boxes 
only.
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Seminar 
Presentation Form

1. Project Information

2. Marks.

3. Comments

4. Total Marks

By scrolling down the 
page, the following items 
can be found:

5. Presentation marks for 
the supervised group.

6. Assessment rubric

* Fill in the yellow boxes 
only.

11

1

2

3

4



Peer Review

Peer Review sheet show 
the peer review results 
and comments of the 
students towards their 
team member.

Facilitator can use the 
three progressive peer 
review results to supervise 
the group.

The peer review results will 
be updated immediately 
once students completed 
their review.
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Group and 
Assessment 
Schedule

This sheet has the 
information on the 
groups and the weekly 
assessment schedule.

Only coordinator is 
allowed to edit this sheet. 
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Saving the Marks

The marks will be 
automatically saved to Google 
drive when connected to the 
internet, or saved to the 
device when not connected to 
the internet (need to enable 
offline mode). 

In order the marks to reach 
the coordinator, connect to 
the internet and make sure 
the save status is

No other marks submission 
process is needed.
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Overall Marks

Marks summary sheet 
shows a live update of 
the students marks 
under the facilitator 
supervision.

Marks of every 
assessment, total marks, 
grade and PLO 
achievement can be 
found in this sheet.
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Facilitator File Sheets List

1. Weekly Forms
2. Prototype Presentation Form
3. Final Product Presentation Form
4. Peer Reviews
5. Overall Marks
6. Group and Schedule
7. PLO
8. Assessment Rubric

Hidden From the Facilitator View
9. Facilitator List
10. Student List
11. Coordinator File Link
12. Prototype Presentation table
13. Final Product Presentation Table
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Lead Coordinator File
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Lead Coordinator File Quick Guide

Write feedback, and print 
report and individual PLO

Set the url of the 4 
coordinator files 

Group the Student
Assign students to division 

and grouping

Create File
Duplicate file, delete 

previous data, and set PLO

01 02 03 04

Link Coordinator Files Prepare Report



Creating the Lead 
Coordinator File

STEP 1:
To create a new Lead 
Coordinator File, right 
click the master file and 
choose ‘make a copy’.

Make a copy of the 
master file will also 
duplicate all the Google 
Forms linked to the 
master file (works for the 
owner of the files only. In 
this case the admin).

STEP 2:
Rename all the new 
created files accordingly. 

Master File

The new 
created file

The new created 
Google forms
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Google Forms Linked to the Lead Coordinator File

● iCODES has the following Google Forms linked to the Lead Coordinator File:

● The new created Google Forms must be updated with the new students list.

● All data (if available) in the sheets listed in Table 2 above must be deleted after the new Lead 
Coordinator File is created.

Table 2: Google Forms

No Google Forms Title Sheet Name in the Lead Coordinator File

1 Peer Review 1, 2 and 3. Peer Review # Form Responses

2 Conceptual Prototype Presentation Information CP Form Responses

3 Final Product Presentation Information FP Form Responses

4 Final Product Presentation Materials Submission FP Materials Form Responses

5 Final Report Submission FR Form Responses
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Setting the 
Program Learning 
Outcomes (PLO)

UPDATE PLO

Update the PLO if 
needed.

The PLO will be 
automatically exported to 
facilitator and 
coordinator files. Thus, do 
not update the PLO in 
the facilitator and 
coordinator files.
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Linking to 
Coordinator Files

STEP 1:
Open the Coordinator file 
and copy its URL.

STEP 2:
Paste the URL in the Link 
column as shown in the 
diagram.

* Link to the Coordinator files 
are used to import marks 
from all divisions. These 
marks will be used to 
generate the Course 
Assessment Summary 
Report (CASR) and individual 
PLO. Link to EECS file is used 
to import the EECS 
leaderboard.
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Grouping 
Students

1. UPDATE AIMS LIST

STEP 1:
To update the list, delete 
all names and copy the all 
new list from the 
AIMSweb.

STEP 2:
Copy the red coded 
names to Master List tab.

STEP 3:
Repeat STEP 1 and STEP 2 
for all Sections.

* Ticks on the Master List 
Status column indicate the 
students have been added 
to the Master List tab.
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Grouping 
Students

2. ASSIGN GROUP

STEP 1:
Go to Master List sheet.

STEP 1:
Tick the checkbox to the 
intended division.

STEP 2:
Assign group name 
according to the division.

* Tips: 
1. Use the top table to balance 
the total students.
2. Use filter to hide unwanted 
data. Example: filter the non 
ECE students when assigning 
group to the ECE students.
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Grouping 
Students

3. THE GROUPING LIST

The grouping list for each 
division is generated 
automatically when 
students are assigned to 
a division and a group. 
The list will also be 
automatically exported to 
Coordinator files.

* Tips: The right side table 
can be used as a guide 
when assigning group to 
students, to have a balance 
group member.
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Preparing CASR

All the scores and 
analysis values for the 
CASR are generated 
automatically.

Only the following 
feedbacks need to be 
filled:

1. Modification to 
course

2. Nali implementation
3. Student feedback
4. PLO Reflection
5. Suggestion
6. Implemented CQI 
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Grades and 
PLO Scores

The grades and PLO 
scores are listed by 
program. Thus, there are 
three sheets for the three 
program (Electrical, 
Electronics, and 
Mechatronics)

There is an option to hide 
students that failed the 
course by clicking the 
checkbox at the top right 
corner of the table.
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Dashboard

The dashboard is used for 
monitoring the course 
through the following live 
update plots and tables

1. Evaluation progress by 
division

2. Grade distribution by 
program

3. PLO achievement by 
program

4. Peer review 
submission status
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Lead Coordinator File Sheets List

1. Dashboard
2. EECS Leaderboard
3. File Link

Students Grouping
4. Main Grouping List
5. POWER Grouping List
6. ECE Grouping List
7. COMM Grouping List
8. CMED Grouping List
9. AIMS SKEL Sec.01 List
10. AIMS SKEL Sec.02 List
11. AIMS SKEE Sec.01 List
12. AIMS SKEE Sec.02 List
13. AIMS SKEM Sec.01 List
14. AIMS SKEM Sec.02 List

Assessment
15. Marks POWER

16. Marks ECE
17. Marks COMM
18. Marks CMED
19. Assessment Rubric

Materials
20. Conceptual Prototype 

Information 
21. Final Product Information
22. Final Product 

Presentation Materials
23. Student’s Final Report

Report
24. CASR
25. PLO SKEE
26. PLO SKEL
27. PLO SKEM
28. PLO

Appendix
29. Conceptual Prototype 

Form Responses
30. Final Product Form 

Responses
31. Final Product 

Presentation Form 
Responses

32. Final Report Form 
Responses

33. Peer Review 1 Form 
Responses

34. Peer Review 2 Form 
Responses

35. Peer Review 3 Form 
Responses
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Coordinator File
03
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Coordinator File Quick Guide

Create facilitator files 
and link the file’s url

Prepare Seminar 
Schedule

Assign panels and complete 
the seminar table

Create File
Duplicate file and set Lead 

Coordinator file url

01 02 03

Assign Facilitator



Creating 
Coordinator File
STEP 1:
Open master file → Select 
File → Make a copy →
choose Share it to the same 
people → Ok.

STEP 2:
Open the new file → go to 
Dashboard sheet → choose 
the program from the top 
right dropdown menu.

* Copying the master file from 
within the Google Sheets apps, 
and not from the Google Drive 
is to keep the permission to 
edit the protected sheets to 
both the coordinator and 
admin.
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Link the Lead 
Coordinator File

STEP 1:
Open the Lead 
Coordinator file and copy 
its URL.

STEP 2:
Open the Faci List sheets 
in the Coordinator file 
and paste the URL in the 
Lead Coordinator File 
Link column as shown in 
the diagram.

STEP 3:
Select the cell written 
with #REF! → click Allow 
access.
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Assigning 
Facilitators

1. Assign Facilitator to 
groups

STEP 1:
Open the Faci List sheets. 

STEP 2:
Fill in the group name, 
assigned facilitators 
name and theme to the 
respective columns.

34



Assigning 
Facilitators
2. Create Facilitator File

STEP 1:
Copy the master file and 
rename accordingly.

STEP 2:
Open the new Faci file 
and go to Group and 
Schedule sheets.

STEP 3:
Click the dropdown 
menu on the yellow box 
and choose the group 
name for the assigned 
facilitator.

STEP 4:
Share the file to the 
assigned facilitator.
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Assigning 
Facilitators

3. Link the Facilitator file 
to the Coordinator file.

STEP 1:
Copy the facilitator file 
URL.

STEP 2:
Go to Coordinator file →
open Faci List sheet →
paste the URL in the File 
Link column.

STEP 3:
Hover the cursor to the 
Import Data column and 
click Allow Permission. The 
linking is complete when 
the tick icon appears.
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Preparing Seminar 
Presentation 
Schedule

1. Assign Session and 
Panel Evaluation

STEP 1:
Type the session name in 
Session column.

STEP 2:
Choose academic and 
industry panel from the 
dropdown menu.

* Below are the two 
indicators as guidance to 
choose valid panels:
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Preparing Seminar 
Presentation 
Schedule

2. Complete the Auto-
Generated Presentation 
Table

The following information 
are not included in the 
auto-generated table. 
Thus, need to include 
them manually:

- Date
- Time
- Venue/Meeting Link 

* The auto-generated table 
can be found by scrolling 
down the Presentation 
Sheet.
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The Dashboard

The dashboard is used for 
monitoring the course 
through the following live 
update plots and tables

1. Evaluation progress.

2. Grade distribution.

3. PLO achievement.
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Coordinator File Sheets List

1. Dashboard

Grouping
2. Student List
3. Facilitator List

Assessment
4. Assessment Schedule
5. PLO
6. Overall Marks
7. Conceptual Prototype Presentation Table
8. Conceptual Prototype Presentation 

Comments
9. Final Product Presentation Table
10. Final Product Presentation Comments

11. Peer Review 1 Marks
12. Peer Review 1 Comments
13. Peer Review 2 Marks
14. Peer Review 2 Comments
15. Peer Review 3 Marks
16. Peer Review 3 Comments 

Appendix
17. Facilitator and Industry Panel Marks
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Student’s Progressive Report
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Appendix
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Data Flow

43

No Data Flow

1 Student List LCF|AIMS List → LCF|Master List → LCF|#Division Grouping → CF|Student List →
CF|Marks & FF|Student List → FF|Group and Schedule → FF|Weekly Form.

2 Facilitator/ 
Panel List

CF|Faci List →
(1) CF|Presentation Table.
(2) FF|Faci List → FF|Group and Schedule → FF|Weekly Form.

3 Group List CF|Faci List → CF|Presentation Table → FF|Presentation Table → FF|Prototype
Presentation Form & Final Product Presentation Form.

4 Peer Review Google Forms → LCF|Peer Review Form Responses → CF|Peer Review Responses → CF|Peer
Review Marks & Peer Review Comments → CF|Marks & FF|Peer Review

5 Weekly Marks FF|Weekly Form → FF|M# → FF|Overall Marks → FF|Student List → CF|Faci # →

CF|Marks → LCF|Marks #Division → LCF|PLO #Program → LCF|CASR → LCF|Dashboard.

6 Conceptual 
Presentation 
Marks

FF(Panel)|Prototype Presentation Form → FF(Panel)|Student List → CF|Faci # →

CF|Marks →

(1) FF(Faci)|Student List → FF(Faci)|Prototype Presentation Form & Overall Marks.
(2) LCF|Marks #Division → LCF|PLO #Program → LCF|CASR.

LCF – Lead Coordinator File; CF – Coordinator File; FF – Facilitator File



Data Flow

44

No Data Flow

6 Conceptual 
Presentation Comments

FF(Panel)|Prototype Presentation Form → CF|CP Comments → FF(Faci)|Prototype 
Presentation Form.

7 Conceptual 
Presentation Info

Google Forms → LCF|CP Form Responses → LCF|CP Info → FF(Panel)|Prototype 
Presentation Form.

8 Final Product 
Presentation Marks

FF(Panel)|Final Product Presentation Form → FF(Panel)|Student List → CF|Faci
# → CF|Marks →

(1) FF(Faci)|Student List → FF(Faci)|Final Product Presentation Form 
& Overall Marks.

(2) CF|FP Comments → LCF|EECS Leaderboard → EECSF|Leaderboard.
(3) LCF|Marks #Division → LCF|PLO #Program → LCF|CASR.

9 Final Product 
Presentation Comments

FF(Panel)|Final Product Presentation Form → CF|FP Comments → FF(Faci)|Final 
Product Presentation Form.

10 Final Product 
Presentation Info

Google Forms → LCF|FP Form Responses → LCF|FP Info → FF(Panel)|Final 
Product Presentation Form.

11 Final Product 
Presentation Material

Google Forms → Google Drive Folder & LCF|Material Submission Form Responses 
→ LCF|FP Materials.

12 Final Report Google Forms → Google Drive Folder & LCF|Final Report Form Responses →
LCF|Final Report.

LCF – Lead Coordinator File; CF – Coordinator File; FF – Facilitator File


